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Введение 

Расчѐт течения гомогенных сред (жидкостей или газов) в 

каналах произвольной пространственной формы является актуальной 

задачей. На основании такого расчѐта можно оценить гидравлические 

характеристики того или иного устройства: потери полного давления, 

коэффициент расхода, коэффициент сопротивления и т.д. Тем самым 

можно без проведения эксперимента установить, какой из 

предложенных вариантов конструкции более выгоден с точки зрения 

гидравлического совершенства, либо определить, насколько хорошо 

обеспечивается смешение компонентов в устройстве. 

В данном пособии описывается расчет в пакете ANSYS Fluent 

течения жидкости с учетом явлений массо- и энергообмена в канале 

сложной пространственной формы: на примере расчѐта смешения  

жидкостей разной температуры в Т-образном тройнике с отводом и 

подводом тепла на внешних стенках.  
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Запуск ANSYS Fluent 

Шаг 1. Запуск ANSYS WorkBench осуществляется из главного меню: 

Пуск -> Все программы -> Ansys 14.0 -> . 

Окно программы (рис. 1) состоит из рабочего поля проекта, 

списка компонентов, окна сообщений, окна свойств и ещѐ нескольких 

элементов, которые могут быть включены опционально (список 

файлов, окно статуса проекта и т.п.). 

 

Рис. 1 - Вид окна программы Ansys WorkBench 

Шаг 2. Необходимо сохранить проект во избежание потери данных с 

помощью меню Save As  главного меню. Внимание! Используйте в 

названии папок и файлов только латинские буквы или цифры. 
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Рис. 2 – Сохранение проекта 

Шаг 3. Затем необходимо добавить в рабочее поле модуль  Fluid Flow 

(Fluent). Для этого удерживая левую кнопку мыши  перетащить его на 

свободное поле проекта к любому месту, где появится зелѐный 

пунктирный прямоугольник, разрешающий размещение (рис. 3). 

 
Рис. 3 - Перенос системы анализа потоков Fluent на поле 

проекта 

В добавленном модуле Fluid Flow (Fluent) содержатся 

компоненты с названиями Geometry (геометрическая модель), Mesh 

(сетка), Setup (постановка задачи), Solution (решение), Results (анализ 

результатов). В правой части каждой строки имеется пиктограмма, 

обозначающая еѐ статус, синий знак вопроса показывает, что данный 

пункт пока не определен (ничего не задано). 
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Создание геометрической модели 

Шаг 1. Запуск системы трѐхмерного моделирования Design Modeler. 

Чтобы запустить приложение, достаточно дважды щелкнуть левой 

кнопкой мыши на интересующем пункте. Также можно щелкнуть 

правой кнопкой мыши, например, на пункте Geometry 

(геометрическая модель) и в появившемся контекстном меню (рис. 4) 

выбрать пункт New Geometry (новая геометрия) или Edit (изменить).  

 

Рис. 4 - Создание новой 

геометрической модели 

 

Рис. 5 - Выбор единиц измерения 

будущей модели 

Шаг 2. Открывшееся окно системы трѐхмерного моделирования 

Design Modeler при первом запуске предлагает выбрать единицу 

измерения будущей модели (рис. 5). Нужно выбрать миллиметры 

(Millimeter) и нажать OK.  

Основную часть окна системы трѐхмерного моделирования 

Design Modeler (рис.6) занимает графическое окно, слева от которого 

расположено дерево проекта (Tree Outline) и окно детализации (Details 

View). Также имеются главное меню и панели быстрого, на которых 

расположены кнопки вызова часто используемых команд.  



 8 

 
Рис. 6 - Окно Design Modeler 

Шаг 3. С помощью операции по созданию простых элементов 

геометрии (Primitives) необходимо создать объем цилиндра (рис. 7). В 

окне свойств выбирается: 

Base Plane      XYPlane 

Origin Z Coordinate (сдвиг начала модели)  -100 мм 

Axis Z Component (длина по оси OZ)   200 мм 

Radius       25 мм 

После настройки каждой операции для ее выполнения  или для 

принятия изменений детали нажимается клавиша . 
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Рис. 7 – Создание объема цилиндра 

В дереве проекта появится пункт 1 Part, 1 Body, показывающий, 

что в данный момент проект содержит одну деталь и одно телом. 

Шаг 4. Аналогично предыдущему шагу создается цилиндр меньшего 

диаметра, расположенный вдоль оси OY (рис. 8). В окне свойств 

необходимо указать: 

Axis Z Component (длина по оси OY)   100 мм 

Radius       20 мм 

 

Рис. 8 – Создание объема второго цилиндра 
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Шаг 5. Далее выполняется скругление по границе соединения двух 

цилиндров с помощью операции Blend  на панели 

быстрого доступа. В меню свойств операции указывается радиус 

скругления 5мм и граница соединения (рис. 9). 

 

Рис. 9 – Выполнение скругления 

Шаг 6. Добавление в модель местного расширения. С помощью 

операции по созданию простой геометрии необходимо добавить 

объем тора (рис. 10). На рисунке 11 показано окно свойств операции. 

Для создания объема тора необходимо указать: 

Координаты модели (Origin Definition)  0, 0, 50 

Направление оси (Axis Definition)  0, 0, 1 

Угловой размер тора (Angle)   360
0
 

Внутренний радиус (Inner Radius)  15 мм 

Внешний радиус (Outer Radius)   35 мм 

 

Рис. 10 – Создание объема тора 
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Рис. 11 – Окно свойств операции по созданию объема тора и 

результат операции 

Шаг 7. По аналогии с предыдущим шагом добавляется местное 

уширение в виде тора на вертикальный подвод. Для создания объема 

тора необходимо указать (рис. 12): 

Координаты модели (Origin Definition)  0, 50, 0 

Направление оси (Axis Definition)  0, 1, 0 

Угловой размер тора (Angle)   360
0
 

Внутренний радиус (Inner Radius)  15 мм 

Внешний радиус (Outer Radius)   25 мм 

 

Рис. 12 – Окно свойств операции по созданию объема второго 

тора и результат операции 
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Шаг 8. Использование свойства симметрии модели для уменьшения 

времени расчета. Для разделения модели по плоскости симметрии 

необходимо выбрать функцию  вкладки Tools главного 

меню. В окне свойств операции указывается плоскость симметрии 

детали (ZY) (рис. 13).   

 

Рис. 13 – Создание симметричной модели 

Шаг 9. После окончания построения модели можно закрыть Design 

Modeler и вернуться в Workbench. При этом сохранение модели будет 

выполнено автоматически и в строке геометрической модели 

(Geometry) появится зелѐная галочка, означающая завершенное 

состояние элемента (рис. 14). При этом в строке сетки (Mesh) 

отображаются знак , что означает, что входная информация 

данного блока изменилась и требуется обновление. Чтобы открыть 

сеткогенератор, достаточно дважды щѐлкнуть левой кнопкой мыши 

по данному пункту. При этом произойдет автоматическая загрузка в 

сеткогенератор рассматриваемой геометрической модели. 

 

Рис. 14 - Состояние проекта при возвращения в окно Workbench 
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Создание сеточной модели 

Окно сеткогенератора (рис. 15) состоит из графической части, 

где можно видеть автоматически импортированную модель тройника, 

дерева проекта, окна визуализации, а также других элементов, 

аналогичных элементам Design Modeler. 

 
Рис. 15 - Окно сеткогенератора Meshing с моделью 

Перед непосредственно генерацией сетки необходимо выделить 

границы (в данном случае поверхности) к которым будут применяться 

в дальнейшем различные граничные условия. 

Шаг 1. Помечаем левую боковую грань цилиндра. Для этого в 

графическом окне выбираем левой кнопкой мыши эту границу. Для 

того чтобы можно было выделить поверхность, необходимо выбрать 

соответствующий фильтр выбора  на панели быстрого доступа. 

После выделения элемент приобретет зелѐный цвет. Далее нужно 

нажатием правой кнопки мыши на выделенном объекте вызвать 
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контекстное меню (рис. 16) и выбрать в нѐм пункт Create Named 

Selection  (создать наименованную группу). 

 
 Рис. 16 – Выделение первой входной грани модели 

В появившемся окне Selection Name (название группы) нужно 

ввести название границы inlet1. Название не должно содержать 

пробелов, может включать латинские буквы, цифры, знаки «-» и «_» и 

должно начинаться с буквы. После подтверждения ввода (нажатия 

кнопки OK), в дереве проекта появится группа Named Selections 

(наименования), содержащая только что созданный элемент inlet1 

(рис. 17). 

 
Рис. 17 – Наименованная граница inlet1 в дереве проекта 
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Шаг 2. Аналогичным образом необходимо подписать границы: inlet2 

– верхняя грань, outlet - для правой боковой грани, symmetry – для 

поверхности симметрии. Также необходимо выделить поверхность 

большого тора – nagrevatel, поверхность малого тора – cooler, 

внешние поверхности большого цилиндра – truba1, внешние 

поверхности малого цилиндра – truba2 (рис. 18-20). Выделение по 

отдельности поверхности труб необходимо из-за разной 

шероховатости стенок. Чтобы повернуть модель, используйте 

среднюю кнопку (колѐсико) мыши. Внимание! Одна поверхность не 

может принадлежать двум именованных группам одновременно. 

 

Рис. 18 – Необходимые выделенные границы модели (1) 

 

Рис. 19 – Необходимые выделенные границы модели (2) 
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Рис. 20 – Необходимые выделенные границы модели (3) 

Шаг 3. После выделения границ необходимо задать параметры сетки 

и построить еѐ. Для этого выбираем в дереве проекта пункт Mesh 

(сетка) и в окне детализации устанавливаем значение Relevance Center 

– Fine (точная сетка). Для этого нужно раскрыть (нажать «+») список 

Sizing (рис. 21). Размеры элементов сетки (Sizing) оставим по 

умолчанию. Для построения сетки нужно правой кнопкой мыши 

вызвать контекстное меню и выбрать пункт Update или Generate Mesh 

(рис. 22). Можно также использовать аналогичные кнопки на панели 

инструментов. 

Через какое-то время генерация сетки (рис. 23) закончится, и 

если в дереве проекта выделить элемент Mesh, можно будет видеть 

расчѐтную сетку (рис. 24). Индикатор состояния сетки при этом 

примет вид зелѐной галочки. 
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Рис. 16 - Задание параметров 

сетки 

 
Рис. 22 - Запуск сеткогенерации 

 

 
Рис. 23 - Процесс сеткогенерации 

 
Рис. 24 - Построенная сетка  

 

Шаг 4. Необходимо измельчить сетку вблизи внешних поверхностей 

тела c помощью создания призматического слоя. Для этого в дереве 

сеткогенератора выбираем пункт Mesh, щелкаем по нему ПКМ,  в 

контексном меню выбираем Insert  Inflation  (рис. 25).  
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Рис. 25 - Добавление элемента улучшения сетки 

В окне свойств Inflation в поле геометрии выбираем тело модели 

смесителя (чтобы был доступен выбор объма на панели быстрого 

доступа необходимо выбрать фильтр ). В поле Boundary 

указываются все поверхности модели, за исключением граней 

входа/выхода и симметрии. Для выделения нескольких поверхностей 

необходимо удерживать нажатой клавишу клавиатуры Ctrl. Затем в 

поле метода сгущения указывается выбор толщины первого слоя (First 

Layer Thickness). Затем вводятся параметры призматического слоя 

(рис. 26): 

First Layer Height  0.0005 мм 

Maximum Layers  5 

Growth Rate   1.2 

 

Чтобы изменения вступили в силу, нужно произвести 

обновление проекта нажатием кнопки . Улучшенная расчетная 

сетка представлена на рисунке 27. 
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Рис. 26 – Настройка параметров призматического слоя 

 
Рис. 27 - Улучшенная сетка с местным сгущением 

 

После этого сеткогенератор (Meshing) можно закрыть и 

вернуться в Workbench. Сохранение сетки при этом произойдѐт 

автоматически. На этом этапе можно сохранить расчѐтный проект, 

нажав в окне Workbench кнопку .  

После сохранения можно включить опцию View -> Files и 

просмотреть в появившейся таблице список файлов, относящихся к 

проекту. Это файл геометрии с расширением agdb и сетки - mshdb. В 

этой же таблице указано расположение этих файлов. 

Можно видеть, что статус расчѐтной сетки проекта 

«выполнено» ( ). А строка описания расчѐтной задачи (Setup) готова 

к обновлению ( ).  
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Постановка расчѐтной модели и еѐ решение 

Чтобы перейти в препроцессор, дважды щелкните на элементе 

Setup. При этом появится окно загрузки программы Fluent (рис. 28). В 

нѐм нужно оставить все параметры по умолчанию и нажать OK для 

запуска Fluent. 

 

Рис. 28 - Окно загрузки Fluent 

Окно Fluent (рис. 29) состоит из графического окна, в котором 

можно видеть загруженную модель, окна текстовых сообщений, в 

которое выводятся результаты выполнения команд, дерева проекта и 

панели инструментов. В зависимости от того, какой пункт выбран в 

дереве проекта, открывается соответствующая панель. На панели 

General (общее) собраны инструменты для начальной настройки 

задачи. 
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Рис. 29 – Внешний вид окна Fluent 

Шаг 1. Перед началом расчѐта необходимо проверить сетку на 

наличие ошибок, нажав на панели General кнопку Check (проверка). 

При этом будет выполнена проверка, заключающаяся в определении 

габаритов сетки, минимальных и максимальных объѐмов расчѐтных 

ячеек и площадей их граней (рис. 30). Если в сетке присутствуют 

ошибки, будут выведены соответствующие сообщения. Если ошибок 

нет, сообщение будет выглядеть, как показано на рис. 30. 

 

Рис. 30 - Результат выполнения команды Check 
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Шаг 2. Сначала во вкладке Models (модели) необходимо включить в 

расчет уравнение сохранения энергии. Это позволит моделировать 

процессы теплопереноса. Включения уравнения происходит 

простановкой галочки в появившемся окне (рис. 31). Для 

подтверждения требуется нажать кнопку OK. 

 

Рис. 31 – Включение в расчет уравнения сохранения энергии 

Шаг 3. Для правильного расчета параметров потока необходимо 

включить в расчет модель турбулентности k –  Realizable (рис. 32). 

Для этого во вкладке Models Viscous выбирается модель  

k – epsilon, а в настройках модели выбирается Realizable  

 

Рис. 32 – Выбор модели турбулентности  
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Шаг 4. Добавляется в проект расчѐта новое рабочее тело - воду. Для 

этого нужно перейти на вкладку Materials (вещества) и нажать кнопку 

Create/Edit. По умолчанию в проекте доступны два вещества: воздух 

(air) в качестве текучей среды (fluid) и алюминий (aluminum) в 

качестве сплошной (solid). В появившемся окне свойств Create/Edit 

Materials находятся настройки теплофизических свойств 

используемых веществ. Чтобы добавить новое вещество из 

встроенной базы данных необходимо нажать на кнопку Fluent 

Database. В появившемся окне базы данных веществ Fluent Database 

Materials нужно найти воду (water-liquid(h2o)). Выбранный компонент 

добавляется в проект нажатием кнопки Copy (рис. 33). После это окна 

редактирования свойств рабочего тела закрываются (Close).  

  
Рис. 33 – Добавление в проект нового рабочего тела 

Шаг 5. Необходимо указать новое рабочее тело для расчетной 

модели. Для этого нужно перейти на вкладку Cell Zone Conditions и 

нажать кнопку Edit. В появившемся окне в поле Material Name из 

выпадающего списка выбирается рабочее тело вода water-liquid 

(рис. 34). 
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Рис. 34 – Настройка рабочего тела расчетной зоны 

Шаг 6. Для настройки граничных условий необходимо перейти во 

вкладку Boundary Conditions (граничные условия). Здесь 

отображаются все границы, ранее выделенные в сеткогенераторе. Для 

настройки первого входа в списке граничных условий нужно выбрать 

inlet1, проверить, что типом данного граничного условия является 

velocity-inlet (вход с заданием скорости потока), нажать кнопку Edit и 

в появившемся окне (рис. 35) задать следующие параметры: 

Вкладка Momentum (количество движения): 

Velocity Magnitude (величина скорости) -> 1 m/s 

Turbulence Specification Method -> Intensity and Hudraulic Diameter  

Turbulent Intensity -> 5% 

Hudraulic Diameter -> 0.05 мм 

Вкладка Thermal (термические параметры): 

Temperature -> 293K 
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Рис. 35 – Настройка граничного условия первого входа 

Шаг 7. Аналогично настраивается граничное условие второго 

входа inlet2 (рис. 36). 

Вкладка Momentum (количество движения): 

Velocity Magnitude (величина скорости) -> 0.4 m/s 

Turbulence Specification Method -> Intensity and Hudraulic Diameter  

Turbulent Intensity -> 5% 

Hudraulic Diameter -> 0.04 мм 

Вкладка Thermal (термические параметры): 

Temperature -> 363K 
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Рис. 36 – Настройка граничного условия второго входа  

Шаг 8. Аналогично нужно настроить граничное условие выхода 

(outlet) (рис. 37): 

Type -> pressure-outlet (выход с заданием давления) 

Momentum: 

Gauge Pressure (статическое избыточное давление) -> 0 

Turbulence Specification Method -> Intensity and Hudraulic Diameter  

Backflow Turbulent Intensity -> 5% 

Backflow Hudraulic Diameter -> 0.05 мм 

Вкладка Thermal (термические параметры): 

Backflow Temperature -> 313K 

Любое значение давления во Fluent задаѐтся от уровня опорного 

или ссылочного давления (Operating Pressure), которое по умолчанию 

установлено равным 101325 Па. 
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Рис. 37 – Настройка граничного условия выхода 

Шаг 9. Затем необходимо для границы симметрии применить 

соответствующий тип граничного условия. В поле Type выбирается 

тип symmetry и на запрос программы о его изменении ответить Yes. 

(Да) (рис. 38): 

 

Рис. 38 – Настройка граничного условия симметрии 

Шаг 10. Затем необходимо настроить граничное условие стенки 

трубы большего диаметра truba1. В меню стенки указывается 

шероховатость (Roughness Height) 1 мм (рис. 39). 
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Рис. 39 – Настройка граничного условия стенки truba1 

Шаг 11. По аналогии с предыдущим шагом настраивается граничное 

условие стенки трубы меньшего диаметра truba2. В меню стенки 

указывается шероховатость (Roughness Height) 3 мм (рис. 40). 
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Рис. 40 – Настройка граничного условия стенки truba2 

Шаг 12. Затем настраивается граничное условие нагревателя 

(nagrevatel). Так как эта поверхность относится к поверхности 

большой трубы, для нее указывается шероховатость (Roughness 

Height) 1 мм. Затем во вкладке Thermal выбираются параметры 

конвективного теплообмена (Convection) и указываются следующие 

параметры (рис. 41): 
Heat Transfer Coefficient (коэффицет теплоотдачи) -> 20000 Вт/м2К 

Free Stream Temperature (температура внешней среды) -> 340 К 

 

Данные настройки обеспечат небольшой подогрев жидкости 

вблизи данной границы. 

 
Рис. 41 – Настройка подогрева жидкости 

 

Шаг 13. Затем настраивается граничное условие охладителя (cooller). 

Так как эта поверхность относится к поверхности меньшей трубы, для 

нее указывается шероховатость (Roughness Height) 3 мм. Затем во 

вкладке Thermal выбираются параметры теплового потока (Heat Flux) 

и указываются следующие параметры (рис. 42): 

Heat Flux (плотность теплового потока) -> -150000 Вт/м2 
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Отрицательное значение плотности теплового потока 

показывает на направление из рассматриваемой модели (т.е. отбор 

тепла). Данные настройки обеспечат небольшое охлаждение жидкости 

вблизи данной границы. 

 

Рис. 42 – Настройка охлаждения жидкости 

Шаг 14. Выполнение так называемой инициализации расчѐтной 

модели – заполнения памяти компьютера начальными значениями 

переменных, необходимыми для проведения первой итерации. Для 

инициализации нужно перейти на вкладку Solution Initialization 

(инициализация решения), на панели выбрать стандартный тип 

инициализации (рис. 43) - Standard Initialization. Затем в поле Compute 

from выбирается входная граница (inlet1), в качестве 

инициализационной, и нажимается кнопка Initialize. При этом во всей 

расчетной области начальные параметры в ячейках становятся такими 

же, как на входе. 
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Рис. 43 – Инициализация решения 

Шаг 15. Выполняем сведение решения. Для этого нужно перейти на 

вкладку Run Calculation, ввести в поле Number of Iterations 

(количество итераций) количество итераций 1000 и нажать кнопку 

Calculate (вычислять). При этом начнѐтся процесс поиска решения 

(рис. 44). При поиске решения в графическом окне отображается 

график переменных, так называемых невязок (Residuals) по 

количеству решаемых уравнений, а в текстовом окне выводится 

таблица изменения невязок от итерации к итерации. Когда будет 

завершено требуемое количество итераций или на какой-то итерации 

все невязки окажутся меньше установленного по умолчанию значения 

(0.001), решение считается сошедшимся (Solution is converged), и 

расчѐт заканчивается с появлением окна сообщения, в котором нужно 

нажать OK. Расчет необходимо продолжать до линеаризации невязок. 
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Рис. 44 - Процесс поиска решения 

Шаг 16. Просмотрим результаты расчѐта. Для этого нужно перейти на 

вкладку Graphics and Animations (графика и анимация), выбрать вид 

представления результатов в виде контуров (Contour) (рис. 45). Затем 

нужно поставить галочку Filled (отображение залитых контуров 

параметров), убрать галочку Global Range (отображение параметров 

по всей модели), выбрать параметр потока статическую температуру 

(Static Temperature) и указать поверхность symmetry для отображения. 

Для отображения параметров нажимается клавиша Display (рис. 46). 

 

Рис. 45 – Визуализация распределения статической температуры 
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Рис. 46 – Рассчитанное распределение статической температуры 

на границе симметрии модели 

Шаг 17. Затем необходимо просмотреть значение среднемассовой 

статической температуры потока на выходной границе. Для этого 

нужно перейти в меню Reports  Surface Integrals. В появившемся 

окне выбираем параметры и нажимаем Compute  

(рис. 47): 

Report Type (плотность теплового потока) -> Mass-Weighted Average 

Field Variable ->  Temperature, Static Temperature 

Surfaces -> outlet 

 

Рис. 47 – Определение интегрального параметра потока 
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Шаг 18. Далее необходимо подобрать граничные условия, 

обеспечивающие значение среднемассовой температуры на выходе 

равной 313 К. Для этого необходимо повысить значение скорости 

потока на границе inlet2 до 0,5 м/с и, не проводя инициализации 

продолжить расчет. Для удобства отслеживания изменения 

среднемассовой температуры потока на выходе необходимо добавить 

дополнительный монитор параметров. Для этого выбирается 

Monitors Surface Integrals Greate , в открывшемся меню ставится 

галочка Plot , и выбираются параметры (рис. 48): 

Report Type (плотность теплового потока) -> Mass-Weighted Average 

Field Variable ->  Temperature, Static Temperature 

Surfaces -> outlet 

 

Рис. 48 – Настройка параметров для отображения в ходе 

решения 

Затем графическое окно разделяется на два монитора для 

одновременного отображения параметров с помощью  на панели 
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быстрого доступа. После этого запускается новый расчет. После 

установления температуры на выходной границе можно 

останавливать расчет и повышать скорость потока на втором входе до 

достижения потребного значения. На рисунке 49 отображен поиск 

решения. 

 

Рис. 49 Графики изменения параметров в процессе поиска 

решения 

Дальнейшая работа по оценке результатов расчета будет 

проводится в постпроцессоре CFD-Post. 
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Анализ полученных результатов 

Шаг 1. Для более детального анализа результатов нужно зайти в 

постпроцессор, дважды кликнув на элементе Results. При этом 

откроется окно постпроцессора CFD Post и в него автоматически 

загрузятся результаты расчѐта (рис. 50). 

 
Рис. 50 - Окно постпроцессора с расчѐтной моделью 

 

Шаг 2. Создаѐм линию вдоль оси OX для построения графика . Для 

этого в главном меню выбираем пункт: 

Insert -> Location -> Line  

 

и соглашаемся с именем по умолчанию, нажав OK. 

В окне детализации линии устанавливаем параметры (рис. 51): 

Point 1 ->   0 0 0.05 

Point 2 ->   0 1 0 

Line Type ->  Cut 

и нажимаем Apply. 
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Рис. 51 - Добавление линии Line 1 

Шаг 3. Добавляем график для просмотра распределения параметров 

потока на построенной линии: 

Insert ->  

Меню настройки отображения графиков в виде данных состоит 

из нескольких вкладок. Ниже описаны настройки для отображения 

скорости потока по длине линии. Устанавливаем его параметры в окне 

детализации на нескольких вкладках: 

Вкладка Data Series: 

  Location -> Line 1 

Вкладка X Axis: 

  Variable -> Velocity 

Вкладка Y Axis: 

  Variable -> Y 

И нажимаем Apply. При этом отрисовывается график скорости 

на линии Line (рис. 52). 
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Рис. 52 – Распределение скорости вдоль линии Line 1 

Шаг 4. Создаѐм вспомогательную поверхность в сечении охладителя 

для определения снижения температуры потока. Для этого в главном 

меню выбираем пункт: 

Insert -> Location -> Plane  

и соглашаемся с именем по умолчанию, нажав OK. 

Для возврата визуализации расчетной модели нужно кликнуть 

на вкладке 3D Viewer внизу графического окна. 

Настройки вспомогательной поверхности (рис.53): 
Method -> ZX Plane 

Y -> 0.045 м 

 
Рис. 53 – Построение вспомогательной поверхности 
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Шаг 5. Для определения среднего значения температуры  потока в 

сечении канала за охладителем необходимо перейти во вкладку 

Calculators  Function Calculator. Затем выбираются следующие 

параметры (рис. 54): 

Function ->ave 

Location ->Plane1 

Variable -> Temperature 

Для расчета параметра нажимается Calculate.  

   
Рис. 54. Меню Function Calculator 

После просмотра результатов можно закрыть постпроцессор, и 

сохранить проект Workbench. 
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Преподавателю 

Лабораторная работа, выполняемая по данным методическим 

указаниям является второй в цикле «CAE-системы в МЖГ», 

рассчитана на 4 часа и предполагается следующий порядок 

выполнения работы: 

1. Преподавателем выполняется краткая лекция по 

моделированию течений в каналах сложной пространственной формы 

в форме медиа-презентации: пояснение моделирования течений с 

различной температурой - 0,5 ак.часа; 

2. Под руководством преподавателя или по данным 

метод. указаниям студенты выполняют решение задачи подбора 

соотношения потоков для обеспечения заданной температуры потока 

на выходе модели - 1,5 ак.часа;  

3. Студенты самостоятельно выполняют индивидуальные 

задания по вариантам. По результатам выполнения самостоятельной 

работы преподаватель контролирует усвоение материала. 
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Индивидуальные задания 
Вариант 1 

 
Задание: Рабочее тело: вода. Определить среднюю температуру потока в 

сечении и распределение скорости потока по высоте канала. Шероховатость труб 

50мкм, теплоотдача с внешних стенок: коэффициент теплоотдачи = 0.3, температура 

внешней среды 10 оС. 

 

Вариант 2 

 
Задание: Рабочее тело: вода. Определить среднюю температуру потока в 

сечении и распределение скорости потока по высоте канала. еплоотдача с внешних 

стенок: коэффициент теплоотдачи = 0.1, температура внешней среды 0 оС. 
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Вариант 3 

 
Задание: Рабочее тело: ацетон нагретый до 90оС. Определить среднюю 

скорость потока в сечениях и расход рабочего тела на выходе модели. 

 

Вариант 4 

 
Задание: Рабочее тело: нитробензол. Определить среднюю температуру потока 

и расход рабочего тела в указанных сечениях. 
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Вариант 5 

 
Задание: Рабочее тело: этанол. Граница 1: подвод тепла плотностью  

20 МВт/м2; граница 2: отбор тепла теплоотдачей с =0.4 Вт/м2К, при температуре 

внешней среды 0 оС. Определить среднюю температуру потока и распределение 

температуры по высоте канала в указанных сечениях. 

 

Вариант 6 

 
Задание: Рабочее тело: ртуть разогретая до 20оС. Шероховатость внешних 

стенок 200 мкм. Определить среднее значение давления потока в указанных сечениях. 
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Вариант 7 

 
Задание: Рабочее тело: метанол. Шероховатость внешних стенок труб 50 мкм, 

внешней стенки шара – 150 мкм. Теплоподвод к поверхности шара 200 Вт/м2. 

Определить расход рабочего тела в указанных сечениях. 

 

Вариант 8 

 
Задание: Рабочее тело: вода. Определить распределение температуру потока в 

указанном сечении. Затем, варьируя скоростями потоков на входах, добиться средней 

температуры потока на выходе в 70оС.  
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Вариант 9 

 
Задание: Рабочее тело: скипидар (turpentine). Определить распределение 

скорости потока в указанных сечениях, на основание полученных графиков 

определить расстояние затухания возвратных течений.  

 

Вариант 10 

 
Задание: Рабочее тело: метиловый спирт. Определить распределение скорости 

потока в указанных сечениях. 

 


